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[ntroduction

Introduction to

LINKS Pro
Macintosh

chome to LINKS PRO for Macintosh! You’ve just bought the Mac
version of the extremely popular and award-winning LINKS 386 PRO golf
program — the finest golf simulator available on any personal computer.
Because LINKS PRO for Macintosh is designed to make full use of your
Mac’s capabilities, the hardware requirements (which are listed later in this
chapter) are quite stringent — but when you play it, you'll see why. Whether
you are a novice, or an experienced golfer, you will find that the LINKS PRO




game, and can be printed ot
you understand and play the

o and replay your best shots
__ available at all times, allowing you to watch
| the front and the back while it happens.
ges in elevation between the ball and the pin




Chapter One
Getting Started

first step in using LINKS PRO for Macintosh is to get it onto your hard
This chapter tells you about the game’s hardware requirements, and
ws you how to install it onto your computer.

Hardware Configuration

am is designed to run on a Macintosh with the following minimum

fion:
" (or larger) 256-color monitor
megabytes of RAM (8 is recommended)

gabytes of free hard disk space

6.07 or later (System 7 or later is recommended)
m 7.0 or later for CD version.
le speed or faster CD-ROM drive

LINKS PRO or LINKS PRO Macintosh CD




from Your Hard Disk
has been installed on your hard disk, it
ton. TO load its Own the LINKS PRO f()]dc[_

control club and shot selection in
e following:

)




Chapter Two
In The Clubhouse

In an actual game of golf, you start by deciding who will play, which course
you want to play, whether you want to play a full 18 holes or just the front or
back nine, which clubs you will use, which tees you will hit from, and the

~ options and rules which will be followed during the round.

This chapter briefly takes you through these same preparations. You'll learn
!Ww to set up a new game, choose the players for a round, select a course, and
the course conditions and rules.

rting a New Game

a new game, choose New Game...from the File menu. This brings up
rst of a sequence of Start a New Game... windows. The rest of this
ter gives you step-by-step instructions for using these windows to set up

ies is where you set up your player list. From this
se existing players, or create new ones.




iew all the recorded players in your Recordeq ¢},

. Checkflllzcsr(gndctgfvfl‘;l(s PRO’s features allows you to record , l’:”"
p(l)ayecr.’s game on a certain course, theq replay the game in gle
competition against other gplfers. You'll find a detailed discussjqy
recorded players later in this chapter.

« Check Both to display both the Normal and Recorded golfers in the
Available Golfers list.

A Golfer From The Player List

e the characteristics of an existing player, or
K, click the Create /Edit Golfers... button just
kes you to the Create, Edit, or Delete a Golfer...




CHAPTER TWO—In the Clubhouse

* Black
* Blue
* White
¢ Red

7 Auto Grid - Click one of these three buttons if you want a light green gnd
to appear automatically on the terrain whenever you come to the tee.
For more about the Grid feature, please see Chapter 4.
* On green
* Everywhere
* No auto grid

8 Chipping club — Drag down this menu to view the complete list of
chipping clubs available. To select one of these clubs, drag the
cursor to highlight it, then release the mouse button. For more about
chipping clubs, please turn to the discussion of clubs in Chapter 3.

9 Caddy — If you choose this option, LINKS PRO recommends a club for
you before each shot. The recommended club may or may not be the
best club for your shot, depending on the lie of the ball, wind
strength and direction, and the elevation difference between the ball
and the pin. You are always free to accept this recommendation. or
choose a different club instead.

 you've chosen all the characteristics for your new golfer, click the OK
at the bottom of the screen. This returns you to the Start a New
en, where your new player appears in the Available Golfers list.

sting Player's Settings
characteristics of an existing golfer at any time.

1 the Players menu.

0
&,




:ﬂ!:'d a game ,.‘,‘,':' is, a specific player
sert recorded as a Pla ,
» with this include: o




CHAPTER TWO—In the Clubhouse

. Recorded. All the available recorded players appear in the Available
Golfers list.

R 4 2 Click the name of the recorded player you want to play against to highlight
it. Then, click Add to add it to the Player List.

3 Proceed with the new game setup process as outlined above. You can mix
recorded and created players in the same game.

When You've Chosen Your Player List...

Your completed player list can contain up to eight players. Once you've got a
complete list of players, return to the Start a New Game... screen and click the
OK button at the bottom right. It’s time to move on to the next step...

Choosing Your Course, Holes, and Play Options

Once you've decided who's going to play, it's time to decide where you'll go,
and which holes you'll play once you get there. The next screen is where you
make these choices.

1 Choose your course from the Available Courses list. This list will grow as
you buy add-on course disks in the future. If the list is too long to be
seen all at once, use the scroll bar to the right of the box to move up
or down.

2 Choose which holes you’re going to play. Click the appropriate button to
~ choose the front nine (holes 1-9), the back nine (holes 10-18), or all
- 18 holes.



rary, and do not affect the golfer’s permanent
Tﬂmlkc anent changes, see the instructions f,,
ng Player whcr in this chapter.

gh the optxons The option that appears is
»d in this game.

to turn the Caddy option on or off, Fo
see the Clubs discussion in Chapter 3,

. box if you want to record this

boxes if you want to allow

so close to the hole that




Chapter Three
On the Tee

Y)u and your fellow players have arrived at the starting tees on your chosen
course, and are ready to play! In LINKS PRO for Macintosh — as in the actual
‘game — you select the correct club, take a practice swing, aim your shot, and
n swing away. This chapter explains how to use the pre- and post-shot
ol panels to accomplish each of these steps.

ntrol panel extends across the bottom of the screen most of the time
the course. It contains everything you need to set up your shots, and

Degrees view rotated
from direction of pin
/

- Selected club

=l Button to display
club selection panel

" Wind indicator




| s over/under par score : ;
lﬂ'ﬁ" ""j° tween the ball’s current location and the pin.

x

oeormation, there are 11 rectangular buttons in the control pane|-
. of the Swing Gauge, and three to the far right,
‘to everything that happens during the game.

return to the game. You may select a large or
ay Option (see page 31).

and customize the angle at which
apter 4 to learn how to set up a

-eye view of your position
iewing windows in




CHAPTER THREE—On the Tee

Click this button to view the special control panel that allows you set up your
drop. (The Drop button also appears on the post-shot options screen after any
otherwise unplayable shot.) United States Golf Association rules state that
when you choose to drop from an unplayable lie, you must drop within two
club lengths of the original spot, and no closer to the hole. Off the cart path,
it’s one length, and no closer to the hole. If you decide to drop after hitting
into a water hazard, the ball should be placed as close as possible to the point
where the ball entered the hazard, and no closer to the hole. To drop the ball:

1 Click the Drop button that appears in the main or post-shot control panel.

2 From the new buttons that appear in the control panel, choose the type of
drop you want:

* Select New Position — Choose a new spot within two club lengths of
the previous one. Move the cursor to place the ball-and-tee cursor on
the spot you’ve chosen for the ball’s new position. Click to set the
new position.

* Back Up 50 Feet — Moves the ball 50 feet back toward the spot you
last hit it.

* Return to Original Spot —Replace the ball in the spot it landed after
the last shot. Click the Hit From Here button to lock in the new drop
position you've chosen, or Cancel to cancel the drop and return to
the game. (You can’t cancel if you're dropping out of a hazard.)

player scheduled to hit and let the next player hit. The skipped
get another chance after everyone else has had a turn.

ur current position. When




‘o change the direction you face in the Main Vi?w- screen,
turn any direction and take a look around you. (It's particyy,
behind a tree and want to see where you're headeq |
not for aiming: to do that, please refer to the Aiming
n on page 20. Here’s how it works:

in the control panel. A compass appears, and the
nges to a Redraw button with two arrow buttons

edraw button is the degrees of rotation from
arrow symbol displays the direction

%




CHAPTER THREE—On the Tee

* Wedges — The three wedges—pitching, sand, and loft—are actually irons,
but they have extremely angled club faces. Because of this, wedges
hit the ball higher in the air, causing the ball to travel a shorter
distance in the air and roll less after it lands. Choose a wedge when
you're close to a green, and want the ball to land there and stay put.

2 the cursor on the Club button to view the current player’s full list of
hese are the clubs you chose for the player when he or she was created.
it change the contents of the club bag during a round.
t club has a red button next to it. To choose another club, simply
the green buttons.

erage distance for a specific club, place the cursor arrow on it.
in red at the bottom of the list.

addy option when you created your player, LINKS PRO
a club for you before each shot. Consider this advice
ed club may not always be the best club for your shot,
uch as the current lie of the ball, wind strength and
erence in elevation between the ball and the pin. You are
dy’s advice, or choose a different club instead.

d Gauge

uge are located in the center of the control panel, and
ng sequence. See Chapter Four, Playing the Game,
etting up and executing a swing.

right of the Swing Gauge allow you to choose

e ball and take a practice swing
o the left

swing. Usually used close

k Putt instead of




r-right corner of the control panel shows the
Jall is currently sitting. You may encounter 16 differen

Rough
Sand
Stream
Water

ed in the bottom right corner of the
the direction the wind is blowing in




CHAPTER THREE—On the Tee

power level of the swing. If you release before or on the 12 o’clock
mark, your swing will be softer and more controlled, making the
snap (the second part of the swing) more likely to be accurate. If
you release in the red area (after the 12 o’clock mark), your swing
will be more powerful than normal and your snap will need to be
almost perfect to avoid severely hooking or slicing the shot.

3 When the yellow indicator reaches the end of the red area at the top of the
swing gauge, it bounces back around. When it reaches the green line
at 6 o’clock, click the mouse button. A second yellow line marks the
second release point.

The point at which you click here determines how straight the shot
will go. This is called the snap. If you click before the 6 o’clock
mark. the shot will hook to the left. If you click after it, the shot will
slice to the right. The severity of the hook or slice depends on both

“how close you get to the 6 o’clock mark, and, how powerfully you
~ swing. The more powerful the swing, the greater the hook or slice.

ot Control Panel

sbot, the control panel displays a different set of buttons and
. The name of the current player appears in the top-left corner of
along with the number of shots he or she has taken so far on

*s name is the shot information:
distance the ball traveled before it hit the ground
1 distance the ball traveled, both in the air and on the

nce between the ball's new location and the pin.

pformation is a box that gives you more information
: and any special options or penalties that apply

“! LI

ws you who is Next To Hit. To
club this golfer chose for his
s the current lie of the ball. In

4.




the player who is supposed (0 hit next.
View the control panel.

appear when appropriate:
: muﬂtgans are a game option, this button appears. (;|

gimmies are a game option, and you are on the
'the hole, click this button to take the gimn%ir:en'




Chapter Four
Game Options

INKS PRO for Macintosh contains quite a few features that enhance the
ng experience, and make it more fun to play. This chapter covers these
It talks about:
e score card
playing the onscreen grid
r and course statistics
g the game through multiple windows
up a practice game
y of graphics and sound options
ustom shots

d displays the players’ names, playing levels, over/under par
es for each hole, along with other standard score card

number of shots taken on the front nine)
number of shots taken on the back nine)
ber of shots taken on all 18 holes.
‘mulligans and gimmies taken by each player.
the different tee boxes to the pin on each hole
p numbers for each hole.

W to your screen template, so you can
information on choosing viewing




and Printing ¢ Statistics Screens

\ and records three different sets of
ve statistics. The complete list of all statistics apper,

you lwve played the course at least once; CdCh
tistics are updated. Eighteen different course
or every hole.

appear immediately after a round is

he statistics generated by the players




CHAPTER FOUR—Game Options

The great thing about statistics is that they are based on actual results. By
king at various elements of your game, you can identify the areas where
have the greatest opportunity for improvement. Here are some examples:

* Print the statistics from your most recent game. Note the holes in which
~ you were over par; then use the Practice option on the File menu to
repeat those holes until you’ve mastered them. You may also review
the average score for each hole on a particular course and identify
those which give you the greatest challenge. Go to the Course Stats
area under the Stats menu and select the course you want to work on.

these Player Stats:
% of Drives on Fairway—Your optimum percentage should be close
10 100%.
o of Greens in Regulation—Your optimum percentage should be
se to 100%.
Distance to Pin—Keep this number as small as you can, and
birdie percentage should increase.
e Strokes Taken—Keep this statistic close to or under par.

Practice Game

ate driving range or chipping and putting green in LINKS
Instead, you can practice any hole on any course you
OWS you to become very familiar with your favorite
play by practicing in the specific areas that give you
lice your driving off any tee, and your chipping and
the greens. Here's how to set up a practice round:

ch is almost identical to the first Start a New
may practice with up to eight players.
ayer List box.

you decide not to practice,
Game sequence.)




Check the Course Conditions.

selected practice hole. Click Cancel to close the
‘window without setting up a practice game.
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Displaying the Grid

t:{;lgagilio E:)r Mac‘mlosh offers a grid feature that's useful when e
ding the terrain on the course. When you select this feat .yf)u'nmj
green grid covers the terrain in the Main View window. The .dﬁrt',d light
mywhere on the course, but it's most useful on the grcéns i

o display the grid, si : - :
pyo zr = ogt. simply click the Grid button in the control panel before

e Auto-Grid
LINKUS PIEO to turn the grid on automatically whenever it's your
rmation becomes part of an individual player’s personal i
: s personal settings.
-Grid to a player’s settings: > -

nu, and select Create/Edit/Delete from the Players menu.

ne of the player to whose settings you want to add the Auto-

d under the Animation List box. Click in the checkbox to
of the three options:

The grid appears automatically whenever you are on

here — the grid appears automatically, everywhere on the
se, during your turn.
Grid—The grid never comes on automatically. You can
it on manually from the control panel.

¥

y make the Auto-Grid option permanent.

from two different grid sizes. To change the size:
and select Display Options .

Large or Small button to select your preferred

b




w screen that displays the Main View plus b,
all up to you. The eight viewing window include

View is the only window that must appesr ,;
et window in which the golfer appears and
viey 'h All the other viewing windows 4,

ich the golfer appears at half the
. The advantage of the “small”




CHAPTER FOUR—Game Options

to see other areas which are not currently visible. The R button at
the bottom will return the Top View to its original position and
magnification.

4 Setup — The Setup viewing window allows you to change the swing
plane, the golfer’s stance, the position of the ball, and the club face
angle. For directions on how to use the Setup to create a custom
shot, see Setting Up A Custom Shot, earlier in this chapter.

Distance — This chart show the average distance each club will hit
e ball at the beginner, amateur, and professional play levels.

d — The Score Card includes the names of the players, their
» their over/under par scores, and their scores for each hole, as
other information typically found on a score card, including:

distances from the different tee boxes to the pin on each hole
par and handicap for each hole
number of strokes per hole for each player
mber of mulligans and gimmies taken by each player

of the Score Card is the Out total (the number of shots

front nine). On the back, you'll find the In total (the
hots taken on the back nine), plus the grand Total for all

play Back/Display Front button at the lower right to
side of the Score Card.

in order to do this. Make sure the printer is
properly, and that you have the appropriate




Windows

S PRO for Macintosh can be viewed i, one,

ed only as a vertical half. In
ical half, horizontal half, or

Card and Profile all can be
or quarter screen. These
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Viewing the Introduction

The QuickTime movie that plays when you start the game may be viewed
again by selecting Intro from the Options menu. Click the mouse or press any
key to abort playback at any time.

Game Options

om the Game Options window, you can change the following settings at any
while a game is in progress:

o Green conditions
* Gimmies

Options from the Options menu to view this window. Then, click
s of the options you want to change. Click OK to return to the
Jeave the Game Options window without changing any settings.

e the wind or green conditions if you are recording a game.

S’ sound effects at any time during the game.

choose Sound Options. The sounds fall into four

s — Natural non-game sounds like birds, frogs, wind,
on.
Player comments made while the ball is in the air
— Player comments made after the ball has landed
related noises, such as the whoosh of a swinging club,
hits the water, the thunk as it hits a tree, and so on.

effects, click the checkbox next to it. When you're
the game. Or, click Cancel to return to the game

re are trade-offs between high-speed gameplay
PRO for Macintosh, unlike most other
-to-beauty balance has been left to you.
she possnble resolution, but find

willing to trade some graphic




you may decide to sacrifice some resoly,

z stant skyline, and keep the foreground items in sharp oy,

xperiment, and find the combinations that vy ¢

m m.-ll :
megabytes of RAM in your Mac, we suggest yoy

or you

' trick before you change the game’s display Options;

top. and select Restart from the Special meny.

ely off, and as the Restart process begins, press
Shift key. Continue to hold it during the entire
is deactivates all the accessory programs in
‘would otherwise launch during the starmp
‘memory to devote to LINKS PRO.

e the Shift key and launch LINKS PRO

AM (the minimum needed to play
this procedure every time in order to
 procedure is optional — but it

s menu and select
/en sections. To choose

corresponding
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0 the most likely to affect the computer’s speed.

on — Slightly blocky images — a small sacrifice of

on — More blocky than the above options.

- Very blocky objects, with very little detail. But it’s fast.

thﬂ graphic quality of the course terrain. This terrain

rrain up to about 50 yards
from about 50 to 150 yards
yond 150 yards
an choose the rendering quality you prefer. Click
the graphic quality, MIN to speed up the
romise between the two.

e area near the MAX  setting, since it’s the
ded speed configuration appears to the right of

eed by eliminating some rendering features.

n, trees and other objects will cast realistic

s will scale upward, if needed, as
oduce a more “blocky” appearance.

11 grid option.




'Mw draw the ball larger when it’s in flight.

ate the way your computer uses memory

t this option, LINKS PRO will load ALL the
RAM at the start of the game. The loading
Jonger at the start of the game, but you

.k—with dividends—in faster gameplay.

ostic of your game if it doesn’t seem o
ou turn on this option, LINKS will
r accuracy as it reads it into RAM
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a host — the person who will set up the game. This person selects
Host Network Game from the File menu, and follows the directions
below to get things started.

nect the remote players. These players select Join Network Game
from the File menu, and follow the directions below to join the host.
Recorded players may not be used in a network game.

work games are played with no wind, and normal greens.

etwork Game
this is the command you use to initiate the game. It’s very much
A New Game...screen described in Chapter 2.

screen contains a Player List — which, at this point, contains just
players available on the host machine. Select the golfers who will
ontrolled from the host computer, and click OK.

rse from the list that appears, and click in the checkbox to
hether mulligans will be allowed. When you’re done, click

the game on the network. When the game is
w player list appears, showing which players — both
ote — have joined the game.

appear on the Player List, click OK. The Select
ions screen appears, allowing each player to
ing level, and caddy option for each player.
0 opt to record their games by clicking

start game at first tee.




also choose to record a players

from your CompU(cr- You can
; done.
) now searches the network for any network games that are opep

and displays them onscreen in a list. Select the game you wan

to the right of the list: Zones, Open/Join, and Cancel,
ivided into different regions (or zones), and your host
erent zone. If this is the case, click Zone to view 4
our network. When you find the right one, highlight it.

nessage appears: Waiting for Host to Start
nd wait. When the host is ready, you'll

' you're waiting for other
the top of the screen telling




Chapter Five

overs basic file management and other software operations in
Macintosh. It deals with adding and removing players during
games, deleting information, and (finally) quitting the game.

emoving Players During a Round

yers to a game in progress — and remove them as well — as
more than eight golfers total.

the current game:
enu, select Add/Remove In Current Game. The
> In Current Game screen appears.

fers box, click the name of the player you want to add.
to the Player List. To create a new golfer, click
and proceed according the directions on page 10.

game with your new player, or Cancel to return

er unchanged.

ove In Current Game. The
en appears.




en from the menu that appears.
\cliCk Own’




ics (Cumulative Totals)
Played — All the holes you have played with your

Played — Holes played divided by 18 (used for
stats).
— Average number of shots taken per 18 holes.

er of holes-in-one.
) — The longest drive off the tee that landed

V'Verage of all drives that landed in the
ves off the tee that landed in the

f the tee that landed in the




Statistics

hole not using the putter. ; B
Average Chip-Ins per Round — Average number of times you chip-in per

., 18 hotes
Pin — On par 3 holes, the average distance to the hole

,Rmmd — Average number of times you use the Drop

ige number of shots needed to finish par 3 holes.
umber of shots needed to finish par 4 holes.




APPENDIX A—Player, Course, and Game Statistics

Over par.
* # of Others — Number of times players finish this hole
strokes over par.
* # of Chip-Ins — Number of times players have hit the ball in the hole not
using the putter.
* Avg. Putts (All Greens) — Average number of putts taken on this hole.
* Avg. Putts (Greens in Reg.) — Average number of putts after reaching the
green in regulation.
* % Drives in Fairway — Percentage of drives off the tee that landed in the
fairway.
* % Greens in Regulation — Percentage of time the green has been reached
in regulation.
Average Drive (All) — Average of all drives off the tee using D1 or D2.
verage Drive (Fairways only) — Average of all drives off the tee that
landed in the fairway using D1 or D2.

more than two

t9 Par — Number of strokes officially deemed necessary to finish the
irst nine holes.

ber of holes the player finished.
g the round.
the player hit during the round.




r of times the player finished a hole more than two

rway only) — The longest drive off the tee that landed

nes the player reached a par 3




Appendix B

rrequently-Asked

°T answers some frequently-asked questions about LINKS PRO for

includes our customer support and warranty information. To

d ours) and phone charges, we éncourage you to turn to this
us for help.

mount of available RAM affect game speed?
up to about 8 MB RAM. If you have less, adding
gram quite a bit. Of course, the program’s speed
the game settings. Raising the settings will
wering the settings will always increase the

difference in game speed when I turn
. with a lot of memory, changing the

2. If you have a slow computer
aphics settings should make a




rol panel, the Skip button in the top-right corner

player on the current hole, the next time he or she
will be red. This is to remind you to skip the
click the Continue button when the Skip
hit after the screen draws.

uring a replay?
golfer during replays requires significant
vn game play. We are working on a
es to allow reverse animations as
changes will be available in a later
ster, we’ll let you know when it’s




APPENDIX B——Frequently—Asked Questions

Q: How do you produce the courses?

T receiving permission from the course owners,
e plans, topographical maps, and other pertinent in
ape the entire course and surroundings, and take s
rocks, shrubs, buildings, and other objects on the
aerial photographs, which help us to correc
ns, hazards, and trees. This process takes five to ten days. Then,

ght to ten weeks, the Access course construction team uses a

S to convert the information into a playable and extremely
urse.

We obtain copies of the
formation, We

till photographs of the
course. We also take
tly place the fairways,

ral courses which you have not done that are considered
st famous in the world. Do you plan to produce them

thing more than to offer all of the finest championship
however, prefer to guard their privacy and have, so
0 our offers. We certainly hope to always produce the
ind that LINKS PRO users will be satisfied with our

metimes pick the wrong club?
ased solely on the distance from the ball to the
d does not take into account the difference in
ction, or your style of play. The caddy
are free to choose another club at any time.

Technical Help Line?
that you cannot solve on your own after




ss software product or to receive an updated product
FREEat 1-800-800-4880. Or, you may FAX your




E— |

APPENDIX B—Frequently-Askeq Questions

enclosed software product and this manual

are copyrighted and ] rights are
Software, Incorporated.” No part of this ma

reserved by

warrants to the original consumer purchaser that the diskettes furnished in
be free from defects in materials and workmanship (as evidence by your receipt).
pplied as part of this product prove to be defective, and provided that the
retumns the media to Access Software, Inc. (in the U.S, and Canada) and U.S.
0pe) in accordance with the instructions in the following paragraph, Access
Gold Limited, will replace any defective diskettes free of charge. This
days following the purchase of this product (dated purchase receipt should

Ul

ent diskette, please return the diskette only, postage prepaid to Access
d Limited at the address below, accompanied by a statement of the
hase receipt, your name and return address.

cumentation are provided “as is”. There is not warranty of
ess for a particular use, and no other warranty of any kind,
the software, diskettes or documentation, except as expressly
Accordingly, the entire risk as to the use, results and
nd documentation is assumed by the user. In no event will
r organization for any consequential, special or indirect
alfunction of this product, including without
, permitted by law, damages for personal injury,
possibility of any such damages or loss.
y of Access Software arising out of any
) will not exceed the manufacturers

ks of Access Software, Inc. All




Pro CD Quick Reference

The Swing Panel

Number of strokes over (+) or Button to skip over the
under (-) Par for current player  player scheduled to hit

Number of shots taken Button fo display
non-obtrusive grid

0 far on current hole

to displa
mp panzl
Button to display
Top View panel © >

Drop Ball panel
1d Swinging

ng Window, drag the mouse
nyou want to go.

Button to displa
location of the

Button to la)
Proﬂlopeg{:lp Y

Selected club

Button to take

a gimmie

: L Draw
@ Siraight

Button to display
Rotate panel

| Gimmie] | Rotate | .’

Degrees view rotated
from direction of pin

Selected club

s —— Button to display

Ur‘f"I' {
r.'

Display of current
lie of the ball with
short description

club selection panel

Club Distances

Driver 1
Driver 2
2 Wood
3 Wood
4 Wood
5 Wood
6 Wood
7 Wood
1 Iron
2 Iron
3 Iron
4 |ron
5 Iron
6 Iron
7 lron
8 Iron
9 Iron

SW
Lw

275yd
275yd
260yd
250yd
235yd
215yd
200yd
190yd
235yd
220yd
205yd
195yd
185yd
172yd
160yd
148yd
135yd
120yd

90yd

70yd




